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Glossary 
 

Backup A saved file that is a second copy of a file for security reasons 
 

Cell One of the boxes that makes up a table 
 

Clip art  This is a collection of drawings and pictures that can be 
inserted into a Word document 
 

Ruler A guide for layout settings on the menu bar 
 

Shortcut An icon that you can select that will open a folder, file or 
program somewhere else 
 

Status bar This shows the page number of displayed page, section of 
page, and page number/total number of pages in a Word 
document 
 

Task bar This is the bar at the bottom of the computer screen next to the 
Start button. It is where all active programs and other tasks are 
identified 
 

Toolbar A line of icons that are shortcuts to actions performed by a 
program 
 

Wordprocessor A program that allows us to input, edit and reproduce text. 
Microsoft Word is a word processing program   
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Using Microsoft Word 

What is Microsoft Word? 
Microsoft Word is a program for helping us to prepare documents. It is mostly useful as 
a wordprocessor. A wordprocessor is a program that allows us to type text on a 
computer and then edit or make changes to this text and print or display the text in 
particular ways. This booklet was prepared using Microsoft Word. We will use 
MSWord from now on to refer to Microsoft Word. 
 
In our study and work you can use MSWord for many things. For example, you could 
use it to write a letter, or a student worksheet or test, or to prepare an assignment. We 
will be using MSWord to help us prepare the report for our project on Indonesia. First, 
let us have a look at some of the things that we can do with MSWord 
 

Starting up MSWord 
 You will need to work with your computer for the following exercises 
 

 3.1 Computer Activity One 
 
1. You already know how to turn the computer on (Module 1.1 Activity 4.1). If 

your computer is not on then start it up now 
2. We can start up MSWord in several ways. One way is to double click on the 

MSWord icon on the desktop.  
 
 
 

3. Another way is to start MSWord from the program files in the Start Menu. Start 
MSWord now. 

4. You should get a screen that looks a little like the one on the next page. Don’t 
worry if yours is a little bit different 

 
 
 
 
 
 
 
 
 
 
We can use less paper when using computers by not printing too often. Do your 

work on the computer screen and save paper. 
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Figure 1:  a blank Word document 

 
 
The screen above represents a page of paper. At the top of the screen we have various 
toolbars that we can use. We will explain some of these tools as we go, however a more 
detailed diagram and explanation of these is provided for you later. We can ‘type’ text 
on the image of the ‘paper’ on the screen by using the computer keyboard.  
 

 3.2 Computer Activity Two 
Typing some text 
 
1. You will notice a single blinking beam (like this |) on the top left hand of the 

white part of the page. This is called the curser and it is where any typing will 
start from. When you move the mouse over the white page you will see that it 
becomes an ‘I’ beam (whereas over the edge of the page it is an arrow) 

 
2. Type the following text into your blank page: 

 
Papua New Guinea is a land of great diversity. There is diversity of 
languages, of landforms and of native plants and animals. People come 
from all over the world to visit Papua New Guinea. 
 
Papua New Guinea is one of the World’s amazing places 

 
3. You can leave a space or go to the next line by typing the enter key at any time 
 
4. If you make a mistake press the Backspace key. Don’t worry about your typing 

speed. 
 
5. How did you go? Next we will do some editing of our work 
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Basic editing 
You probably made some mistakes while you were typing and there may be some 
mistakes on your computer screen page. That doesn’t matter at this stage as one of the 
advantages of using a word processor is that we can fix up our mistakes and improve 
our writing quite easily later. 
 

 3.3 Computer Activity Three 
Fixing mistakes 
 
1. You can move the curser to the position where you want to fix the mistake and 

click the left mouse button. This will place a single beam (i.e. | ) at the point 
where you want to make a change. You can also use the arrow buttons on your 
keyboard to move around. Try this 

2. The delete key deletes text forward and the Backspace key deletes text 
backwards. Try this 

3. If there is a spelling mistake the word will be underlined with a red line. If you 
place the curser over the word and click the right mouse button. A list of 
correctly spelt word will be presented and you can choose the correct one. Try 
this 

4. Grammar mistakes or queries are shown with a green underline. Right mouse 
click will give you a suggestion, which if you select will change your text. Be 
careful though as sometimes you are right and the computer is wrong. 

5. You can use other ways to move around your document. The four arrow keys 
will move your curser up and down and left and right. The PgUp key moves 
your curse to the top of your document and the PgDn moves it to the bottom of 
the text. 

 
 

 3.4 Computer Activity Four 
Basic editing 
1. Bold, Italicised, Underline: Look at the tool bars at the top of the screen.  You 

will see a B, I, and U on one of the tool bars. If you hold your curser over each 
of these in turn you will see Bold, Italic and Underline appear. We can bold, 
italicise and underline text by selecting the text to be changed then clicking on 
the button of our choice. Try this on the section of text that you have typed. Bold 
Papua New Guinea, Italicise great and Underline diversity. 

2. Changing fonts: The font is the style of the text that we are using. This is 
indicated in the tool bar and in the picture below is the window with Times 
New Roman in it 
 
 
 
 
Move your curser to the downward arrow at the right of the font window and a 
list of available fonts appear. You can use the scroll bar to see the complete list.  
Select the section of your text -There is diversity of languages, of landforms 
and of native plants and animals and apply a different font to it. You can do 
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this a number of times with different fonts to see what some of the fonts look 
like.  

3. Font size: Font size is indicated in the little window to the right of the font 
window. In the above example the size is 12. We can make fonts small or we can 

make them large. The little downward arrow next to the font size window 
will show us the available sizes. Select the last sentence in your text and change 
the font size. 

4. Cut, copy and paste: We can ‘cut’ out some text and place it in another place or 
make a copy of some text and place it somewhere. On the tool bar underneath 
the font box, you will see three icons that represent cut, copy and paste.  

5. Highlight a section of your text, such as the first sentence, and copy it using the 
copy icon. Paste this at the end of your passage 

6. Drag and drop: Another way to move text around is to drag and drop it. 
Highlight a section of text (your second sentence), and while holding down the 
left mouse button drag the mouse pointer to the new place you want to put the 
text, then let the left mouse button go. 

7. Undo and redo: These two buttons are very useful. They are on the toolbar and 
are represented by the icons 
The left pointing icon is undo and the right pointing icon is the redo. When we 
click the undo icon it will undo the last thing we did. We can keep on clicking to 
undo the second last, third last etc. The redo icon does the opposite, so that if we 
undo something, and we didn’t mean to, we can redo it again. Give it a go. Undo 
the last 5 things you did, now redo them.  

8. Spend a little time experimenting with further editing of your document. It 
doesn’t matter what you do with it, as this is just an exercise. You might like to 
add some more text or add a heading.  

 

Saving and opening files 
In module one, we learnt how to save a file. Here we will do a little bit more on this.  
We will also learn how to open a file that we have already created. Saving correctly is 
important.  
 

 3.5 Computer Activity Five 
Saving and opening files 
 
1. We need to save the file that we have created in the last exercise above. When 

you have finished experimenting with your editing go to the file menu and select 
Save As. Give your file a name (e.g. Exercise 2) and select a folder to place it 
(should be My Documents)  

2. Once a file has a name we don’t need to use the Save As function each time, we 
can just use save and the computer will save the latest version of the file under 
the original name and in the same place. 

3. We can also use a shortcut on the taskbar to save files once they have been 
created and saved once. The shortcut is an icon of a ‘floppy disc’  (can you 
find it?). A further shortcut is to press the Ctrl (control) key first, hold it down 
while you press S at the same time. 
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Inserting a picture or graphic 
We can insert pictures or graphics into our text in a number of ways. 
 
 
 

 
3.6 Computer Activity Six 
Inserting Clipart 
 
Find the place in your document where you want to insert a picture from the clip art 
1. Go to the Insert menu and select Picture then Clip Art  
2. Either select from the pictures you see or use the search function by typing in a search 

term (eg. Man or woman)  
3. Double click on the picture and it will be placed into your text 
4. You can resize the picture and move it to where you want to place it  
5. We can also place pictures  that have been saved to file  
6. [Advanced features: if you double click on the picture a dialogue box  

appears. By selecting the layout tab and then the ‘in front of text’ tab, 
you can move the picture on top of text. Try some of the other picture 
layout controls] 

 

Printing 
Once you have finished preparing your text and editing it, you can print your document. 
However, it is very important that you check your document carefully on the computer 
screen and fix any problems before you print, as printing costs money. 
 
 
3.7 Computer Activity Seven 
Printing 
 
1. Once you have fully checked your document then make sure that there is paper in 

the printer that you are using 
2. Go to the File menu and select Print 
3. A dialogue box will appear  
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Figure 2: Print dialogue box 

 
4. In the print dialogue box you can choose your printer. Sometimes more than 

one printer is connected to a network (check with your lecturer for the printer 
to use). You can also select All pages or the current page being viewed or you 
can specify specific pages. 

5. Once you are satisfied that the settings are what you want then click the OK 
button 

6. Go to the printer to collect your work 

Project text 
You will need to start preparing text for your project. You should have looked through 
Encarta and the notes in Module 1.2 and made some notes on the subtopics of the 
project question. Now we will begin to prepare a MSWord document of your project. 
 

 3.8 Computer Activity Eight 
Preparing a MSWord project file 
1. First, you will need to set up a file for your project. If MSWord is not open then 

open it. 
2. Save As a file with the following format – yournameCLproject  
3. Type in the project headings i.e.  

   Overview  
   Climate 
   Population characteristics 

    Languages 
               Cultural Highlights 
4. Make a space between each heading so that you can start to type in some text for 

it 
5. The best way to develop your project report is just to type your information 

under the headings that we have already put in place. Use the notes that you 
have already prepared. 

6. Don’t worry about the layout of your work at this stage but concentrate on 
getting your information well constructed 

7. Save your file using the save command 
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The importance of saving 
We need to save the file so we can have a record of our work. If we don’t save our file 
the work that we have done will be lost. It is important to save work while we are 
doing it, so every five minutes or so you should save your work. When we do this 
our work will be kept up to date and secure.  

Backup 
Sometimes we might also like to have a back up of our file, in case we spoil the original 
or something just goes wrong. We can save another version of our file as a back up by 
saving it as a new name using the Save As command. For example, we could save the 
above file as yournameCLprojectBU. Remember that your computer will save to the 
current opened file so once a back up is created you should close it and re open the 
original file.  
 

Editing your project report 

 3.9 Computer Activity Nine 
Editing your project report for layout 
 
There are a number of things that you can do to improve your project so that it looks 
attractive 
 
1. Add a title page.  If your place your curser at the very beginning of your text you 

can insert a new blank page at the very beginning of your report by going to Insert 
on the menu bar and selecting Break. A window like the one below will appear 
 
 

 
 
 
 
 
 
 
 
 
 

Figure 3:  the Break dialogue box 
 
 
2. Make sure Page break is selected like in the example above (if not then left click 

your curser on the small circle next to it), then press OK 
3. A new page should appear on your screen before your existing text 
4. Prepare a title page with: 

i) your name  
ii) your class group 
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iii) your assignment title 
iv) your lecturers name 

5. Experiment with text positioning by using the centering text command 
First you need to select the text you wish to format, then select one of the alignment 
tools shown here to place your text either, aligned left, centred, aligned right or 
justified (aligned on left and right sides of the page)  

6. Use bold, underlining or Italics and change your font size etc to get the effect you 
want 

7. Use headings. You can format your headings by using existing heading formats that 
are found in the style box in the top left hand menu (underneath the ‘Edit’ and 
‘View’ commands). To use this feature highlight a heading text and select a heading 
style.  

8. Pasting a picture.  You can copy a picture and past it into a Word document. From 
the Start Menu open Encarta. [Note your Word document will still be open and you 
can see it on the Task Bar]. Search for a picture that you want to copy. Select the 
picture. Use the right mouse button to copy the picture.  Select your document from 
the Task Bar. Place the curser where you would like to paste the picture. Use the 
paste command in the Edit menu (or from the tool bar) to paste the picture into 
your document.   

 
 
 
 
 
 
 
 
 
 
 
 

 
 
You should work on your project to improve it both in the quality of your text and in the 
way that you present it. Don’t forget to save your work! 
 
 
 



10  ICT 1.3 Using Microsoft Word 

Student Support Material 

Options in Word 
 
Tables 
 
Let us make a table in word. A table is when we organize our typing into different 
columns and rows. 
 

  3.10 Computer Activity Ten 
Making a table 
 
1. Identify how many columns and rows you will have in your table. For this 

example I will use three columns and three rows 
2. Go to the Table menu in the main menu bar 
3. Select Insert table 
4. A wizard will appear like the one below 
 

 
Figure 4:  the Table dialogue box 

 
5. Using the up and down triangles change the number of columns and the number 

of rows figures to what you needs – I have chosen 3 each in my example 
6. Click OK 
7. A table outline will appear like below 
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Editing a table 
 
Once you have created a table shell then you can type your information into each cell by 
moving the curser to the cell you want. A cell is each of the little boxes that makes up a 
table 
You can add new rows by simply using the Tab key 
You can change the dimensions of your table by selecting it and then changing the 
settings in the ruler 
  
 
 

 


